Chapter 10 Managing Media

Overview

This chapter describes how to:

. View the contents of media
. De-activate and remove media in your managed media set
. Perform physical media operations
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Viewing the Media Tree
Media Manager provides detailed information on media created by the current installation,
including:

. Number of media within each media set
. Percentage of capacity utilized on the media



. Detailed session information

Managed media are located in the managed media library. Within the managed media
library, media sets appear in order from the least frequently used media set through the
most frequently used.

The program does not create a non-managed library until you create custom job that
specifies non-managed media.

Since non-managed media are not required for rotation, they may be moved permanently
off-site. Non-managed media are labeled by the user. When creating jobs written to non-
managed media, you can prevent the program from recording the contents of the session in
the File History Database.

In all media sets, the most recently written sessions appear at the top of the list. While all

media created for the current library appear in the tree, any sessions that were not tracked

in the File History Database, do not appear. The prefix “CP” indicates a backup session.
NOTE: An optical disk is considered a single media, although each side is

labeled separately. For example, media A:1 and A:2 may refer to different
sides of the same disk.

Refreshing the Media Tree

Occasionally, you may want to refresh the media tree to display the most recent operations,
such as a Forget or backup operation, performed by you or other users.

To view the most current media tree

> Open the Operations menu and select Refresh Media Tree. The media
tree displays the most current information about your media library.

Media Manager Tool Bar

The Media Manager tool bar provides a short cut to commonly used operations:
Display Mounted Media—Show the Mounted Media window.
Restore—Restore the selected item(s).

Define Filter—Specify the filename pattern and/or other criteria that the program should
search the session for.

Enable Filter—Apply the defined filter and display only those files that match the filename
pattern and/or criteria for the current session.

Help—-Open the Help menu.

Media Summary Report

Backup Director can print a list of devices currently configured for Backup Director
operations. See chapter 7 for information about viewing and printing the Media Summary
report.



Viewing Directories and Files

The session window displays the directories and files from a single volume that were written
to a particular session. All sessions written by automatic jobs are tracked in the File History
Database. By tagging directories and files, you can restore the tagged items to the disk. See
chapter 9 for information about finding files and filtering the files. Media Manager provides a
subset of the parameters described in File Manager.

To view the session window

1. Highlight the session for which you want to display directories and files.

2. Open the View menu and select Session Window.
> You can also double-click the highlighted session to view the session
window.

3. The program begins building the directory and file windows. This can take some time,

depending on the size and complexity of the directory structure. The program allows
you to pause from building after it completes a directory. You can view the file
window or perform an activity elsewhere while the program is building the directory
structure.

> To interrupt the building process, choose the Pause button after the
program builds the directory you want to see. Choose the Resume button to
let the program continue building directories.

In this window, the volume appears at the top of the tree, followed by a list of directories.
The file information includes the date and time stamp, and byte size of each file. The session
window also displays “suspect” file information.

4, View the desired directories and files. To view files and directories contained in
untracked sessions, you must journal the media.

Viewing Mounted Media

While the session window generated by the View/Session Window option displays the media
records in the File History Database, the session information displayed in the Mounted Media
window is read directly from the media.

Through the Mounted Media window, you can read media containing untracked sessions
written by the current installation and PALDF- or SIDF-formatted media. Backup Director also
provides information about the type of media mounted and any bar code label.

Parameter
Description

Location The name of the device the media is loaded on. If the device is
an autoloader, this parameter also indicates the slot position of the
media.

Media The label of the media. If the media has no label, the

program identifies the media as a Clean (cleaning tape), Blank,
Unformatted (new optical disks), or Unknown media (the program



does not recognized the file system).

Format The data format of the media: SIDF, PALDF, or
Unknown. SIDF refers to System Independent Data Format. PALDF is a
Palindrome proprietary format used in earlier versions. Unknown
indicates a file system format not recognized by the program.

Type The type of media loaded, for example, 4mm DAT.

Bar Code The numbers corresponding to the media's bar code label, if
applicable.

From the Mounted Media window you can access physical media operations listed in the
Operations menu. Journal, Verify, and Format options are also available as control buttons on
the window. Your autoloader may require additional instruction to perform operations. See
the AutoLoader Software Guide for information about performing operations from the
Robotics menu.

Restoring Directories and Files

You can restore directories and files from tracked or untracked sessions. To restore tracked
files, File Manager provides the most convenient method of restoring. To restore from
untracked sessions or files, you must use Media Manager. First, journal the mounted media
with the untracked session. From that point you can choose to restore an entire session or
select a session to view its directories and files.

See chapter 6 for details on restoring files and directories through Media Manager.

Journaling Media

The Journal option displays the contents on a physical media. While the program performs
this operation, you can access another program or manager, but do not exit this manager.
You will abort the journal operation.

To journal a media

1. Load the media you want to journal, if it is not currently loaded.

2. Open the View menu and select Mounted Media. The Mounted Media window
appears.

3. Highlight one of the media on the Mounted Media window.

4, Open the Operations menu and select Journal. The program always performs the

Journal operation in attended mode (Prompt With Questions option is turned off).
The Session List window appears. The media label appears in the title bar.

Parameter
Description

Media Name The type of session and session number.

Elapsed Time Displays the time that passes between initiating the journal



Archives

Backups

Free Space

Capacity

Resource

Session

Items
Size
Date

Time

Phase

State

operation and ending the journal operation.

The number of bytes used for archive files. This is also
expressed as a percentage of the media's total capacity. This
parameter is only used by media created on Storage Manager or
Network Archivist installations.

The number of bytes used for backup files. This is also
expressed as a percentage of the media's total capacity.

The number of bytes available for writing additional sessions.
This is also expressed as a percentage of the media's total capacity.

The number of bytes in the media's total storage capacity. This
is also expressed as a percentage of the media's total capacity.

The resource on which the session was written.

The session label and number. Backup Director produces
three types of sessions: CP—Backup sessions; DC —System Control
Database sessions; DH —File History Database sessions.

The number corresponds to the number of sessions of
that type in the media library. If tracked, the backup sessions are
always visible on the media tree. The database sessions are only
visible through the Journal operation.

Retired media or media from other installations may
display “SV” sessions. These sessions contain permanent file copies
produced by these installations (either Storage Manager or Network
Archivist).

The number of items contained in the session.
The size of the session in megabytes.
The date on which the session was written.

The time at which the program began writing the
session.

The activity of the user interface. Usually, the phase will
be Opening the media.

The state of the device being used for the operation
being performed on the mounted media.

> To view the directories and files residing on a session, highlight a
session and choose the View button. The media session window appears. The
file window lists files located under the highlighted directory. Locate, sort, and
build directories just as you would for the database session window.

5. The program prompts you to indicate whether you are finished journaling the media.
Choose Yes to end journaling and exit the media session window.



6. You can end the operation at any time by choosing the Close button in the media
session and the Session List windows.

De-activating and Removing Media

A significant number of soft errors indicates that you may need to de-activate, or, in more
severe cases, remove the media records from your database. The Retire and Forget options
allow you to prevent data from being written to damaged media by removing the media
from your rotation. Or, in the case of non-managed media, removing the media from the list
of existing media. You should consider these options when:

. The System Messages window contains messages indicating that a
media's integrity is questionable.
. A Verify operation results in excessive soft errors. If the errors exceed

the recommended threshold for the type of media you are using, the media is
probably damaged.

Before you retire (de-activate) or forget (remove records of) media, you may want to verify
that the device is not causing the soft errors.

To ensure that the errors are not due to hardware failures, perform the media
troubleshooting tests described in chapter 11.

Retiring Media

If only certain sessions on the tape are damaged, use the Retire option. Retiring a media
maintains the media in the media set, but removes it from your active rotation. The next
time the program rotates to this media set, it will require a blank media and continue the
media number sequence. For example, if you retire media MONDAY:1 and MONDAY:2, the
new media added to the set will be MONDAY:3 and MONDAY:4, if necessary. You can still
restore files using retired media.

TIP: After you perform a full backup operation, the Retire option is useful for
a snapshot of your installation and moving the media off site permanently.

To retire media

1. Highlight the appropriate icon. To retire all of the media in a media set, select the
media set icon. You cannot select media from multiple media sets for a single
operation.

2. Open the Operations menu and select Retire. The program prompts you to confirm

the operation. The media continues to be represented in the tree since you can still
perform restore operations with it.

Forgetting Media

When you do not want or cannot use the media or session for future restore operations, use
the Forget option. The Forget option should be reserved for media or sessions that are
virtually unreadable. You should use your Forget option if you receive a fatal tape error and
an Operations/Verify operation also produces unacceptable errors.

The Forget option clears all references to those file copies from the File History Databases.
Forgotten media or sessions disappear from the media tree. Forget should be used only



when you have located damaged or lost sessions on a media. If necessary, you can restore
data from a forgotten media or session by using the Mounted Media window.

NOTE: The program does not erase forgotten sessions and media. While they
no longer appear in the database, the program can still display forgotten
sessions through the Mounted Media window. If any files still exist on disk,
Backup Director writes files on forgotten sessions to another media set on
rotation day.

To forget a session or media

1. Highlight the media icon. You can only select one item for each operation.

2. Open the Operations menu and select Forget. The program prompts you to confirm

the operation. The item disappears from the media tree. During the next automatic

job, the program updates the media records in the File History Database to reflect the
change in the status of the file versions.

Other Utility Operations

You must perform the following operations from the Mounted Media window.

Secure Erase

Only 8mm and QIC drives support the Secure Erase option. Use Secure Erase to erase the
entire length of a tape to prevent any data on the media from being recovered. To simply re-
use media, use the Format option.

For some drives this process may take several hours. A bulk eraser might erase the media
more quickly than this operation.

To erase a data from media

> Select the media you want to erase. Open the Operations menu and
select Secure Erase. If you try to erase a media that is in active rotation, the
program warns you. Backup Director prompts you to confirm the operation.

If the media already has sessions written by Backup
Director, the program warns you that sessions will be destroyed
when it erases the media.

Format

Use the Format option to format new media or to re-use media. Format is required on non-
SMS formatted media before using with Backup Director and on Random Access Devices
such as optical devices. The formatting time varies with the media's length and capacity. You
do not need to format new, blank tape “out of the box.” You should use Operations/Format
only when you are recycling used media.

To format a media

> Select the media you want to format. Open the Operations menu and
select Format.



If the media already has sessions written by Backup
Director, the program warns you that sessions will be destroyed
when it formats the media.

WARNING: Formatting active media in your current media library is
not recommended; you risk losing specific file versions. Backup
Director re-writes files that are still on disk to another media at the
next rotation.

Tension

The Tension option simply spins forward and backward through the current tape. This is
useful for tensioning infrequently used tapes, to minimize potential damage to the tape
caused by magnetic print-through. Backup Director performs frequent start and stop
operations on the tape. When using older backup devices such as DC 6000 and 8mm
(2.2GB) tape drives, you should tension the tape. It is a good idea to tension your tapes
after every other use of the tape, regardless of the operation you perform.

This feature is not supported on DDS DAT or 8mm (5.0GB) drives.
To tension a tape

> Select the media you want to tension. Open the Operations menu and
select Tension. Backup Director prompts you to confirm the operation.

Verify

Use Verify to verify that the contents of a media are readable using ECC (Error Correcting
Code) and CRC (Cyclical Redundancy Code) checking. Any errors found will be reported to
the screen and to the System Messages window. The program can only perform this
operation if the CRC Data Verification Level for Backups parameter was set to
Calculate or Verify at the time the sessions were written.

To perform a Verify operation
> Select the media you want to perform the operation on. Open the

Operations menu and select Verify. Backup Director prompts you to confirm
the operation.

Copy

Copy allows you to copy the contents of one backup media to another. Two backup devices
are required. The two backup media do not have to be the same type. For example, you can
copy from a DC 6000 drive to a DDS-DAT drive.

Duplicate media are considered non-managed; the program does not request duplicate

media for automatic jobs. For restore operations, Backup Director treats the duplicate
exactly as it would the original so you can restore from it at anytime.

Benefits

The benefits of the utility can be seen in a number of situations:



. Moving backups offsite—Copy your daily backup sessions to duplicate
media to move the duplicate offsite. Duplicate media do not appear in the
media library.

. Restoring when original media is forgotten or retired—If your original
media has unrecoverable physical errors, you can retire or forget it, and, if
necessary, restore data from the duplicate media.

. Upgrading backup media—you can copy an older library on to new
media in case you need to restore from it in the future.

Once a duplicate media is created, Backup Director can only copy the source media to the
duplicate media.

To copy media

1. Load blank media in the target device and the source media in the source device.

2. Highlight the mounted media you want to copy (the source media).

3. Open the Operations menu and select Copy. The Copy dialog box appears listing the
configured devices.

4, Specify the source device and target device.

5. Choose OK to submit the job. If media is not mounted in either device, a pop-up

window appears. The media will be assigned “COPY” as its type with the source
media's label as its internal label name.

> If the source media has more data than can fit on the target media, the
program notifies you that it did not copy the session. You must then insert a
new media. The program begins copying the session that was interrupted
while writing to the first duplicate media.

Using Duplicate Media

Restore Operations

When performing restore operations, Backup Director will treat the duplicate media as an
original. You would most likely want to use a duplicate media if your original was damaged
or lost.

If during a restore operation, Backup Director requests a specific media, you may substitute
the duplicate. However, you must ensure that your duplicate has been kept up-to-date,
otherwise, the files on the original may not exist on the duplicate.

Appending to Duplicate Media

You can append to the duplicate media, but only if you are copying from the same source
media used for the original copy operation. This allows you to copy data from a media
numerous times without having to erase it first. Sessions that already exist on the duplicate
will not be copied again.

For example, if you copied managed media MEDIA:A:1 and then later updated MEDIA:A:1
and copied it again, only the changed data on MEDIA:A:1 would get copied to your duplicate
media.



Copying Media after Backup Operations

If you want to immediately copy a media after a backup is complete, link the copy operation
to follow a backup operation. You need at least two devices, the device on which the backup
is written and the device with blank media (or existing duplicate media if you are appending)
to which the copy will be written.

Writing Backup Sessions

Backup Director cannot perform backup operations on duplicate media and will reject all

requested operations, even in unattended mode (When Prompt With Questions option is
turned off).

Maintaining Your Media

Tape Handling

Tapes are very sensitive to environmental conditions. Exercise great care in storing and
using them. Physical damage to the tape is often the root cause of unsuccessful recovery
from backup media. This damage can be caused by equipment, environment, or
mishandling.

The second most probable cause of tape failure is contamination. Contamination can pre-
exist, originate, or be created during every phase of the storage process.

If you take care of your tape drive and store the tapes according to recommended
procedures below, you can successfully recover data from media that is over 10 years old!

Palindrome recommends the following procedures to enhance the shelf life of your
company's precious data.

For information on maintaining your backup device, see Appendix B, “Maintaining Your Tape
Drive.”

Use Only Data-certified Tapes

Palindrome recommends using high-quality tapes and cleaning the tape drive after the initial
pass of a new tape cartridge.

NOTE: Use only data grade tape cartridges! Do not use video or analog grade
tapes, no matter how economically appealing they may be. They are generally
of a lesser quality, and are not approved for use with tape drives.

Palindrome customers have experienced a greater number of tape errors using unapproved
tapes than with approved tapes. Additionally, use of contaminated tapes may transfer
contaminates to the tape drive heads which can lead to contamination of quality tapes.

TIP: Contact Palindrome's BBS and download the APRVMED.ASC to obtain a
list of approved media.

Keep Your Tapes Clean

Dirty tape drive heads and media account for one of the most probable reasons for recovery



failure. Keep the tapes clean in both the operation and storage areas. Do not permit
smoking, eating, or drinking in the area where you perform backups. Keep everything clean.

The tape drive you use for recording backup data must also be exceptionally clean. Also, be
sure to operate the tape drive using the manufacturer's electrical and mechanical
specifications.

NOTE: Backup Director performs frequent start and stop operations on the
tape. When using older backup devices such as DC 6000 and 8mm (2.2GB)
tape drives, you should tension the tape. Tension your tapes after every other
use of the tape, regardless of the operation you perform. DDS DAT and 8mm,
5GB tapes cannot be tensioned.

Store Your Tapes Properly

Store the tapes on edge. Do not stack them horizontally.

Store your cartridges in their protective box, away from heat sources and electromagnetic
fields when they are not mounted in the tape drive. Do not place cartridges on the
computer, monitor, or any other peripheral device.

TIP: Do not locate a tape drive unit near a printer, a copier, or any other
source of magnetic fields or paper dust.




